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1 Project 3 – Flow through a Ball Valve 
During this project a typical ball value will be analyzed to determine the difference in flow between the 
valve being fully open and half opened.  Autodesk Inventor will be used to create the fluid model that will 
be used in Autodesk Simulation to complete the CFD analysis. 
 
 

1.1 Project 3 - Instructions 

Preparing the Model in Autodesk Inventor 
 

1. Open Ball Valve Fluid.iam in Autodesk Inventor Professional 2012. 

 
 
 
2. Click Assemble tab | Component panel | Shrinkwrap to open the Create Shrinkwrap Part 

dialog. 
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3. On the Create Shrinkwrap Part dialog box click the Browse Templates button. 
 

 
 
 

4. Click the English Tab and select the Standard (in).ipt template.  Click OK twice to continue. 
 

 
 

NOTE: When working in a metric assembly click the Metric tab and select the appropriate 
template. 
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5. Complete the following items in the Assembly Shrinkwrap Options dialog: 

 
• Select the Single solid body merging out seams between planar faces option under 

Style. 
• Click OK. 
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6. Save the new created part.  The model will look like below and will be filled solid model 

 

 
 

 
 

7. Create a New Assembly file using the English | Standard (in).iam template file. 
 
 

8. Use the Place Component tool to insert both the Ball Valve.iam and the Ball 
Valve_Shrinkwrap_1.ipt into the new assembly. 

 

 
 
  



ME 24-688 – Week 14 

 Unsteady External Fluid Flow Analysis 
    

  
ME 24-688 – Introduction to CAD/CAE Tools Page 5 of 33 
 

 
9. Right-Click on the Ball Valve_Shrinkwrap_1:1 occurrence in the Browser and select iProperties.   

Then select the Occurrence tab.  Set the X Offset, Y Offset and Z Offset to 0 and check the 
check Grounded checkbox under Properties.  Click OK to continue. 

 

 
 

NOTE: This will overlay the Ball Valve:1 and the Ball Valve_Shrinkwrap_1:1 occurrences. 
 
 

10. Save the assembly as Ball Valve Fluid.iam. 
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11. Create a new Part file using the English | Standard (in).ipt template. 
 
 

12. Click Finish Sketch from the Exit panel. 
 
 

13. Click Model tab | Create panel | Derive to open the Open dialog. 
 

 
 
 

14. Select the Ball Valve Fluid.iam file and click Open.  If prompted to update the assembly select 
Yes. 

 
 

15. In the Derived Assembly dialog box change the icon next to Ball Valve:1  by clicking the icon 
until a Red symbol is shown.  This will subtract the selected component from the other 
component.  Click OK to continue. 
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16. The following model will be created leaving you with a solid representing the fluid in the valve 
assembly. 

 

 
 
 

17. To simplify the mode for simulation we will split the model.  Click Model tab | Modify panel | 
Split to open the Split dialog.  Select the XZ Origin workplace of the part from the Browser.  
Change the split type to Trim Solid and Flip the Remove direction if required so the bottom is 
removed.  Click OK to continue. 
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18. Save the part as Ball Valve Fluid.ipt.  
 

 
 
 

19. To save this file for use later during the analysis we will export a STEP file.  From the main menu 
select Save As | Save Copy As.  Select STEP Files (*.stp, *.ste, *step) as the Save as type.  
Enter Ball Value Fluid Open.stp as the new file name and click Save to complete. 
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20. Switch the active document to the already open Ball Valve.iam file. 
 
 

21. Now we will change the handle position to a partial closed position.  Click Assembly tab | 
Manage panel | Parameters to open the Parameters dialog.  Change the value of the 
HandleAngle parameter to the 45.00 deg option. Click Done to complete. 

 

 
 
 

22. The handle position will change.  Now switch to the Ball Valve Fluid.ipt file that is already open. 
 
  



ME 24-688 – Week 14 

 Unsteady External Fluid Flow Analysis 
    

  
ME 24-688 – Introduction to CAD/CAE Tools Page 10 of 33 
 

 
 

23. Notice the model is not updated yet.  Click the Update button as shown below to update the 
derived part to the latest assembly geometry. 

 

 
 

 
 
 
 

24. From the main menu select Save As | Save Copy As.  Select STEP Files (*.stp, *.ste, *step) as 
the Save as type.  Enter Ball Value Fluid Half Open.stp as the new file name and click Save to 
complete. 

 
 

25. Save all file and Close Autodesk Inventor. 
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Running the Analysis in Autodesk Simulation 
 

1. Open the Ball Valve Fluid Open.stp file in Autodesk Simulation 2012.  Accept the option to Use 
STEP File Units which will be inch. 

 
 

2. A dialog will appear asking you to choose the analysis type for this model.  Click the arrow to the 
right of the analysis type field, select the Fluid Flow pull-out menu, and choose the Unsteady 
Fluid Flow analysis type.  Click the OK button to continue. 

 

 
 
 

3. Click Mesh tab | Mesh panel | 3D Mesh Settings to open the Model Mesh Settings dialog.  
Click the Options button. 

 
 

4. Under the Surface panel complete the following items: 
 

• Select Absolute Mesh Size as the Type. 
• Enter 0.05 as the Size. 
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5. Select the Solid panel and complete the following items: 
 

• Select the Tetrahedra and wedges (boundary layer) radio button. 
• Click the Tetrahedra tab. 
• Enter 0.05 in the Total Extrusion Distance field. 

 

 
 
 

6. Click OK twice to complete the Model Mesh Settings. 
 
 

7. Select the Right, Left, and Symmetry faces as shown below. 
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8. Right-click in the display area and select the CAD Mesh Options | Exclude from Boundary 
Layer option. 

 
 

9. Click on the Mesh tab | Mesh panel | Generate 3D Mesh to mesh the model.  When asked to 
review the mesh results select No. 

 
 

10. Right-Click on the Material node in the FEA Editor Browser for Part 1 and select Edit Material. 
 

 
 
 

11. Select Water as the material under the Liquid folder and click OK to complete. 
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12. Ensure the selection type is Point for Shape and Surfaces for Select. 

 
 

13. Select the large flat surface along the symmetry plane as shown below. 
 

 
 
 

14. Click Setup tab | Fluid Flow Loads panel | Prescribed Velocity to open the Prescribed 
Velocity Object dialog. 

 
 

15. Select the Y Magnitude checkbox and click OK to continue. 
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16. Select the left outside end surface as shown below. 
 

 
 
 

17. Click Setup tab | Fluid Flow Loads panel | Inlet Outlet to assign an inlet\outlet to the surface. 
 
 

18. Select the right side end surface as shown below. 

 
 

19. Click Setup tab | Fluid Flow Loads panel | Prescribed Velocity to open the Prescribed 
Velocity Object dialog. 
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20. Complete the following items in the Prescribed Velocity Object dialog: 
 

• Check the X Magnitude checkbox. 
• Enter -55 in the X Magnitude field. 
• Check the Y Magnitude checkbox. 
• Check the Z Magnitude checkbox. 
• Click OK to complete. 

 

 
 
 

21. Click Setup tab | Model Setup panel | Parameters to open the Analysis Parameters dialog. 
 
 

22. Complete the following items in the Analysis Parameters dialog: 
 

• Click the Add Row button. 
• Enter 0 in the first row for the Multiplier column. 
• Enter 20 in the second row for the Steps column. 
• Click OK to complete. 
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23. Now run the analysis by clicking Analysis tab | Analysis panel | Run Simulation.  The analysis 
will take approximately 2 minutes to complete depending on your computer resources. 

 
 

24. Click on the View tab | Results Options panel | Load and Constraint to turn off the display of 
the loads and constraints. 

 
 

25. Click on the on the Results Contours tab | Load Case Options panel | First button to display 
the initial condition. 

 

 
 
 

26. Click on the on the Results Contours tab | Load Case Options panel | Next button to display 
Time Step 1 will be displayed (0.05 s) 

 

 
 
 

27. Right Click on the Presentation folder in the Results Browser and select New Contour 
Presentation to add a contour presentation. 
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28. Add a Particle Path by clicking the Results Contours tab | Velocity and flow panel | Velocity 
pull-down | Magnitude option. 

 

 
 
 

29. Change the selection type to Point for Shape and Nodes for Select. 
 
 

30. Holding the <Ctrl> key, select Eleven (11) nodes. The selected nodes should look similar to the 
image below. 

 

 
 
 

31. Click Results Inquire tab | Flow Visualization panel | Add Particle Paths to open the Particle 
Paths dialog. 
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32. Complete the following items in the Particle Paths dialog. 
 

• Select the Add command under the Nodal Selection field. 
• Press the Particle Path Settings... button. 

 
 

33. Complete the following items in the Particle Path Settings dialog. 
 

• Enter 0.05 in the Time Interval between Introducing Particles field. 
• Enter 40 in the Number of Particles to Introduce field. 
• Click OK to continue. 

 

 
 
 

34. Press <Esc> to dismiss the Particle Paths dialog. 
 

NOTE: Displaying the particle paths has automatically turned on transparency for the model, so 
that the particles within the interior will be clearly visible. 

 
 

35. Click on the on the Results Contours tab | Captures panel | Start button to animate the 
particles path throughout the analysis. 

 
To view the results click the following link: Animate Particle Path 

 
  

http://screencast.com/t/lBuecmf9G
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36. The results will look similar to the image shown below. 
 

 
 
 

NOTE: As the animation proceeds, the particles will flow through the model.  The animation will 
likely be slow at first as all the particle paths are calculated.  Keep the animation running and 
subsequent repetitions should display much more quickly.  When you are finished with the 
particle tracking, use the Results Contours tab | Captures panel | Stop command. 

 
 
 

37. Right Click on the 2 < Unnamed > Contour Presentation with Particle Path Flow Visualization and 
select Clone. 
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38. Right-Click on the Particle Path <Unnamed > and select Edit. 
 

 
 
 

39. On the Particle Paths dialog box click the Use For Plotting Streamlines button.  Press <Esc> 
to close the dialog. 
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40. The results display will look similar to the image shown below now showing the streamlines. 
 

 
 
 

41. Click on the on the Results Contours tab | Captures panel | Start button to animate the 
particles path throughout the analysis. 

 

 
 

To view the results click the following link: Animate Streamline  
 

NOTE:  As the animation proceeds, the streamlines will update as the flow pattern through the 
model changes. When you are finished viewing the streamlines, use the Results Contours tab | 
Captures panel | Stop command. 

 
  

http://screencast.com/t/Tkhns0lc
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42. Click on the Report Browser tab.  

 

 
 
 

NOTE: All three contour presentations have been added. 
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43. Return to the Results Tab and close 3 < Unnamed >. 

 

 
 
 
 

44. Right-Click the HTML Report and select Refresh Report. 
 

 
 
 

NOTE: The Streamline Contour presentation is no longer included in the report. 
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Run the Same Analysis on the Half Open Fluid  

 
45. Open the Ball Valve Fluid Half Open.stp in Autodesk Simulation 2012. 

 
 

46. A dialog will appear asking you to choose the analysis type for this model.  Click the arrow to the 
right of the analysis type field, select the Fluid Flow pull-out menu, and choose the Unsteady 
Fluid Flow analysis type.  Click OK to continue. 

 
 

47. Click Mesh tab | Mesh panel | 3D Mesh Settings to open the Mode Mesh Settings dialog.  
Click the Options button. 

 
 

48. Complete the following items for the Surface type: 
 

• Select the Absolute Mesh Size option in the Type drop-down box. 
• Type 0.05 in the Size field. 
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49. Select the Solid panel and complete the following items: 
 

• Select the Tetrahedra and wedges (boundary layer) radio button. 
• Click the Tetrahedra tab. 
• Enter 0.05 in the Total Extrusion Distance field. 

 

 
 
 

50. Click OK twice to complete the Model Mesh Settings. 
 
 

51. Exclude surfaces from the Boundary Layer.  
 

• Select the Right, Left and Symmetry faces. 
• Right-click in the display area. 
• Select the CAD Mesh Options | Exclude from Boundary Layer option. 
 

 
52. Click on the Mesh tab | Mesh panel | Generate 3D Mesh button to mesh the model. 

 
 

53. Press the No button when asked to view the meshing results. 
 
 

  



ME 24-688 – Week 14 

 Unsteady External Fluid Flow Analysis 
    

  
ME 24-688 – Introduction to CAD/CAE Tools Page 27 of 33 
 

 
 

54. Select Water as the Material for Part 1. 
 
 

55. Add a Prescribed Velocity to the symmetry plane.  Click on the large flat surface along the 
symmetry plane.  Click on the Setup tab | Fluid Flow Loads panel | Prescribed Velocity to 
open the Prescribed Velocity dialog. 

 
 

56. Check the Y Magnitude checkbox and ensure 0 is the Magnitude value.  Click OK to continue. 
 
 

57. Add the Inlets/ Outets by selecting the left end face.  Click on the Setup tab | Fluid Flow Loads 
panel | Inlet Outlet button. 

 
 

58. Select the right end face and add click on the Setup tab | Fluid Flow Loads panel | Prescribed 
Velocity button. 

 
 

59. Complete the following items in the Prescribed Velocity Object dialog: 
 

• Check the X Magnitude checkbox. 
• Enter -55 in the X Magnitude field. 
• Check the Y Magnitude checkbox. 
• Check the Z Magnitude checkbox. 
• Click OK to complete. 
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60. Click Setup tab | Model Setup panel | Parameters to open the Analysis Parameters dialog. 
 
 

61. Complete the following items in the Analysis Parameters dialog: 
 

• Click the Add Row button. 
• Enter 0 in the first row for the Multiplier column. 
• Enter 20 in the second row for the Steps column. 
• Click OK to complete. 
 

 
 
 

62. Now run the analysis by clicking Analysis tab | Analysis panel | Run Simulation.  The analysis 
will take approximately 4 minutes to complete depending on your computer resources. 

 
 

63. Click on the View tab | Results Options panel | Load and Constraint to turn off the display of 
the loads and constraints. 

 
 

64. Add a Contour Presentation.  Right Click on the Presentation folder in the results browser and 
select New Contour Presentation. 

 

 
  
 

65. Add a Particle Path.  Select from the Results Contours tab | Velocity and flow panel | Velocity 
pull-down | Magnitude. 
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66. Holding the <Ctrl> key, select Eleven (11) nodes. The selected nodes should look similar to the 
image below. 

 

 
 
 

67. Click on the Results Inquire tab | Flow Visualization panel | Add Particle Paths button 
 

 
 
 

68. Complete the following within the Particle Paths dialog box. 
 

• Select the Add command under the Nodal Selection field 
• Press the Particle Path Settings... button. 

 
 

69. Complete the followign within the Particle Path Settings dialog: 
 

• Type .05 in the Time interval between introducing particles field. 
• Type 40 in the Number of particles to introduce field. 
• Press the OK button. 

 
 

70. Press <Esc> to dismiss the Particle Paths dialog. 
 

NOTE: Displaying the particle paths has automatically turned on transparency for the model, so 
that the particles within the interior will be clearly visible. 
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71. Animate the Particle Path.  Click on the on the Results Contours tab | Captures panel | Start 
button to animate the particles path throughout the analysis. 

 

 
 
  To view the results click the following link: Animate Particle Path 
 

NOTE: As the animation proceeds, the particles will flow through the model.  The animation will 
likely be slow at first as all the particle paths are calculated.  Keep the animation running and 
subsequent repetitions should display much more quickly.  When you are finished with the 
particle tracking, use the Results Contours tab | Captures panel | Stop command. 

 
  

http://screencast.com/t/0ygozuoNJLWP
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72. Right-Click on the 2 < Unnamed > Contour Presentation with Particle Path Flow Visualization 
and select Clone 

 

 
 
 

73. Right-Click on the Particle Path < Unnamed > and select Edit 
 

 
 
 

74. On the Particle Paths dialog box click Use For Plotting Streamlines.  Close the dialog box. 
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75. The result display will look similar to the image below. 

 
 
 

76. Animate the Streamline.  Click on the on the Results Contours tab | Captures panel | Start 
button to animate the particles path throughout the analysis. 

 
To view the results click the following link: Animate Streamline  

 
  

http://screencast.com/t/1qs5CorgNU7
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77. Graph the Velocity on the outlet.  Click on the Selection tab | Shape panel | Rectangle button. 

 

 
 
 

78. Select the Outlet as shown below. 
 

 
 
 

79. Right-Click in the Graphic area and select Edit New Graph.  Select Maximum Magnitude in the 
Multiple Nodes pull-down. 
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